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January 2025 
 

Fiscal Year Change for Client Info and Work Order Window 
 

 
Path: Admin > Client Info / Preferences 

 
Path: Transactions > Work Order > Records / Identity 
Tab 

Summary: The Fiscal Year settings in Client Info / 
Preferences have been changed. You can select a 
Starting Month and a Starting Day for your fiscal year 
settings. 

A Fiscal Year field has also been added to the Work 
Order window in the More Information section. The 
date range has been included to make it easier for 
managers/technicians to select the correct FY 
option. This can be used in reports to show the Fiscal 
Year (budget year) the work was completed. 

Details:  

The format in the Fiscal Year field drop-down window 
follows this hierarchy:  

• User / Preferences 

• Client Info / Preferences 

• Default MM/dd/yyyy (if neither User nor Client 
Info settings are present) 

The drop-down options span eight fiscal years prior, 
the current fiscal year, and three fiscal years in the 
future. 

Your System Administrator sets the Fiscal Year 
Starting Month and Starting Day in Admin > Client 
Info / Preferences.  

The System Administrator can also make the Work 
Order Fiscal Year field required from Admin > Form 
Attributes > System Form Attributes. 

 

Purchase Requisition Enhancement in Client Info 
 

 
Path: Admin > Client Info / Preferences 

Summary: You now have the option to save a 
Purchase Requisition record without adding line items. 
While the standard process includes item lines, some 
situations require that a record be completed later. 

Details:  

A new Purchase Requisition Category has been added 
in Admin > Client Info / Preferences where the option 
Require Purchase Requisition Part is granted by 
default. 

If you want to save PR records without item lines, you 
can Deny this preference. 

This is our November Voice of the Customer 
enhancement. We would like to thank the University 
of Alabama Birmingham for submitting this 
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enhancement suggestion. WebTMA has evolved into 
the solution it is largely through great feedback and 
suggestions provided by our clients. 

 

User Verification (eSignature) for Finishing/Closing WOs 

 
Path: Admin > User Management > Records / 
Preferences 
 

 
Path: Transactions > Work Orders > Records 
 

 
 

Summary: You now have the option to force User re-
authentication when a work order is Finished or 
Closed. 

This enhancement ensures that the logged-in user is 
the person who modified the Work Order record when 
finishing or closing and is used to keep your records 
in CFR compliance. 

Details: 

To invoke this change, grant the Require eSignature 
On Work Order when Closing/Finishing Preference 
(Admin > User Management > Records / Preferences) 
for users who are allowed to close or finish records. 

On the work order, the Finish Date and Close Date 
fields are disabled for users with this Preference. An 
information icon instructs users to select the Close 
WO or Finish WO commands in the Action Menu. 

The process is as follows: 

1. Complete and Save the work order. 

2. Click Close WO or Finish WO on the Action 
Menu in View mode to open the related flyout.  

3. Complete the needed fields. 

4. Click Save on the flyout. The system refreshes 
and presents the Re-Authenticate login 
window. 

5. Enter login credentials  

6. Click the Re-Authenticate button. 

Quick Post and batch close from WO Browse also 
require re-authentication. Currently it is not available 
on Mobile TMA. 

This is also a Voice of the Customer enhancement. 
We would like to thank Röchling Medical for 
submitting this enhancement suggestion. WebTMA 
has evolved into the solution it is largely through 
great feedback and suggestions provided by our 
clients.  

 

Warehouse Copy Will Clone Records with Inventory 
 Summary: You have the option to make a copy of an 

existing Warehouse and clone all settings including 
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Path: Material > Warehouses 

the Part Inventory Tab of the original – except the 
Quantity, Value, and Available columns on the Tab. 

Details:  

The process is easy. Open an existing Warehouse 
record and click Copy on the toolbar. 

The resulting record is in Add mode and needs a Code 
and Name. 

The new Warehouse is now visible on the Material > 
Parts > Records / Location Tab. 

You can transfer quantities to the new Warehouse 
using Material > Parts > Transfer Parts if needed. 

 

Open Distribution on Batch Closed WOs Now Has Alert 
 

 
Path: Transactions > Work Order > WO Browse 

Summary: If Quote, PR, or PO items that are 
marked for distribution to a Work Order have not 
been received and you attempt to close the Work 
Order, you are alerted that there are Open 
Distributions. 

When you batch close work orders from the WO 
Browse window, the system now gives you an alert 
for open distributions in the same way it does when 
closing from the Work Order window. 

While an alert has always shown in the Work Order 
window, this functionality has been added to the WO 
Browse window as well. 

Details:  

When you close one or more work orders from WO 
Browse that have open distributions, you receive an 
alert and can select from the following: 

Proceed: Clear all Distributions and close all Work 
Orders 

Close Only: Close all Work Orders and 
Distributions remain open 

Skip: Close all Work Orders selected without 
Distributions 

Cancel: Do not Clear Distributions and do not 
close selected Work Orders 

This is our October Voice of the Customer 
enhancement. We would like to thank Colgate 
University and University of Massachusetts - Amherst 
for submitting this enhancement suggestion. 
WebTMA has evolved into the solution it is largely 
through great feedback and suggestions provided by 
our clients. 
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Pending Charges Review/Dispute Export Lines 

 
Path: Accounting > Post Charges > Pending Charges 
Review/Dispute 

Summary: This new development for the Pending 
Charges Review/Dispute window gives you the option 
to export some or all the transactions. 

Details:  

You can check lines on the grid to use the Export 
Selected Transactions button or you have the option 
to Export All Transactions. 

Since there are different transaction types in the grid 
when exported to Excel, each type has its own 
worksheet. The same is true for the accounts. 

 

Linked Documents Toggle View Feature 
 

  
 

  
 Navigation Panel – Linked Documents  

Summary: A new icon  has been added to the 
Navigation Panel. The Toggle Linked Documents View 
icon is used to view by file type (image, .pdf, etc.) or 
by the record to which the files are linked. 

Details:  

The default view categorizes files by the record they 
are attached to. In the first screenshot at left, two 
files are attached to the Equipment record and one is 
attached to the Work Order record. 

Click the  icon to view by file type. The files in the 
second screenshot now show two image files and one 
.PDF file. 



  5 

 

Report Manager Reports Linked to Dashboard 
 

 
Path: Dashboard (Add New Control in Edit mode) 

 

Summary: Most reports in Report Manager are now 
eligible for selection on the Dashboard. 

Details:  

This applies to reports that do not have a record set 
on the Window Toolbar. 

Only reports that do not have the window toolbar 
selected on the report are available for selection in 
the dashboard. 

 

 

 

MTTR and MTBF Report Added to Report Manager 

 
 
Path: Reports > Report Manager / PM 
 
 

Summary: A new report has been added to the PM 
category of the Report Manager to calculate the 
average time it takes to repair a failed component 
and the reliability of a component. 

The report is titled Equipment Availability with MTTR 
and MTBF.  

Details:  

Based on posted downtime, the report shows in hours 
the Available Time, Uptime, Downtime, MTBF, and 
MTTR for a range of equipment in a Facility, Building, 
and Area. 

In addition to Start Date and End Date, you have the 
option to limit the results based on Repair Center, 
Facility, Building, and Equipment Type. The report is 
identified as Special, which means it cannot be copied 
and recreated. 

• MTTR – Mean Time To Repair 

• MTBF – Mean Time Before Failure 
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PM Efficiency by Location Report Added to Report Manager 

 
 
Path: Reports > Report Manager / PM 
 
 

Summary: A new report has been added to the PM 
category of the Report Manager to calculate and 
evaluate PM Efficiency by Location in WebTMA. 

The report is titled PM Efficiency Report by Location. 

Details:  

The report shows the total amount of PM’s generated 
and the total completed within a given time range. It 
also displays your efficiency percentage by Building, 
and the totals by Building.  

Also, it displays your average efficiency percentage 
for all Buildings within the selected time range. 

In addition to Request Date and Completion Date, you 
have the option to limit the results based on Repair 
Center and Facility.  

The report is identified as Special, which means it 
cannot be copied and recreated. 

 

Uptime vs Downtime by Facility Added to Report Manager 
 

 
Path: Reports > Report Manager 

Summary: A new report has been added to the 
Management category of the Report Manager to 
analyze Equipment Uptime and Downtime by Facility. 

The title of the report is Uptime vs Downtime by 
Facility.  

Details: 

The report allows the selection of a Repair Center, a 
Facility, and/or Building and a Work Order date 
range. It displays the Total Uptime % vs Total 
Downtime % for the selected date range. 

In addition to the percentages, it shows Total Uptime 
Hours for all Equipment in the selected RC, Facility, 
Building, the Total Downtime Hours, and the Average 
Downtime Hours. 

Finally, it provides context by showing the Total 
Equipment in the Facility, the Current Equipment Up, 
the Current Equipment Down, and the Total Instances 
of Downtime in the selected date range. 

The report is identified as Special, which means it 
cannot be copied and recreated. 

 



  7 

Key Adjustment Reports Added 
 

  
Path: Material > Key Management > Key Adjustments 

Summary: The Key Adjustments window is used for 
numerous transactions that involve Keys. 

Several reports have been added to the Reports 
section of the Navigation Panel to help speed up your 
use of the Key Module. 

Details:  

The following reports are now available: 

• Key Issuance Receipt 

• Key Lost Receipt 

• Key Return Receipt 

• Key Ring Issuance Receipt 

 

 

Search Functionality Added to Repair Center Assignment 

 
    Example of Spreadsheet Entries 
 

 
Path: Admin > Repair Center Assignment 

Summary: The Repair Center Assignment window 
allows Administrators to upload a populated template 
with the Lookup Types and Lookup Codes that are 
accessible from within a selected Repair Center. 

The results grid now includes Search, Filter, and Sort 
options like other grids in WebTMA. 

Details: 

The window is easy to use. Simply Download 
Template from the window. Note the specific format 
to use for the Lookup Type in the spreadsheet. Be 
sure your Lookup Type name is followed by the term 
‘Type’ with no space. 

Once you have completed the Template, select a 
Repair Center and click the + Upload button on the 
window to select your completed Template. 

The resulting grid includes options to Search, Sort, 
and Filter. 

 
Click the Filter icon to see a search popup. 
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Task Check Group Enhancement 
 

 
Path: Organization > Task > Task Check Group 

Summary: The Task Check Group window is a 
convenient way to add several Master Checks to one 
record. You can now search and filter for Master 
Checks from the Task Check Group window. 

If you have numerous Master Checks (Organization > 
Task > Master Check), this enhancement gives you a 
way to quickly locate the records you need.  

Details: 

A Master Check Code column has been added to the 
results grid, and the check Code, Check Type Code, 
and SubType Code criteria have been added to the 
drop-down list on the Task Check Entry flyout as well 
as the grid on the flyout. 

In addition, a Find button was added in the Filter 
Criteria section to make it more accessible and 
intuitive to the user.  

 

Login URL Reminder Added 
 

 
Path: Admin > User Management > Records  

Summary: The feature that allows selected Users, 
Requestors, and Technicians to log in without using 
an ID and Password was revised earlier this year. 

A reminder has been added to the Login URL flyout to 
remind administrators that the link expires.  

Details:  

The change resolved a security vulnerability, and the 
links expire in 24 hours. 

 

 

AP Payment Window Now Includes UDF Section 
 Summary: A UDF section has been added to the AP 

Payment window. 
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Path: Accounting > Accounts Payable Invoice > AP 
Payment 

If you need to track information that is not on the 
window, this feature allows you to add as many fields 
as needed. 

Details: 

You can set up your UDF fields from Admin > Form 
Attributes > System Form Attributes. Open 
APPayment and scroll to the bottom of the window 
where you can create, name, and establish the layout 
for UDF fields on this window.  

 

Mass Import Biomed Equipment Template Has Preferred RC 
 

 
Path: Admin > Mass Import > Import Dashboard / 
Templates  

Summary: When using the Mass Import module for 
Biomed Equipment, you can now include a Preferred 
Repair Center if needed. 

Details:  

A new Preferred Repair Center column has been 
added next to the Repair Centers column. If a Repair 
Center is added to the new column, the Biomed / 
Repair Centers Tab will have a check mark in the 
Preferred column for imported records. 

Reminder: Only one Repair Center can be entered in 
the Preferred Repair Center column. 

 

Email Format Enhanced 
 Summary: Email messages that were created as 

text-only are now available in HTML format. 

Details:  

Improvements were made to the HTML layout, and 
paragraphs are automatically formatted correctly. 
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 Example email in HTML format 

 

Edit UDF for Accepted Inspection Findings 
 

 
Path: Transactions > Request > Inspection Findings 

Summary: By default, an Accepted Inspection 
Finding record cannot be edited. UDF fields are now 
an exception. 

Details:  

With this change, you can double-check that the 
inspection has been completed by entering data in 
your UDF fields. 

 

Survey Endpoints Enhanced in Swagger 
 

 

Summary: In an ongoing response to our customers’ 
requests, we continue to enhance the endpoints. 

In this release, we have added platform endpoints to 
retrieve surveys sent as well as receive survey 
responses. 

Details: 

These new endpoints have been added to help 
retrieve data for the surveys that are sent and to see 
survey responses.  

Having these endpoints available allows you to share 
survey results on public performance metrics or 
outside Business Intelligence (BI) tools. 
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Swagger Schemas 
 

Request Log Now Filters Tasks by Repair Center 
 

 
Path: Transaction > Request > Request Log 

Summary: Those who use the Request Log window 
and are knowledgeable about Task Codes will find this 
new feature useful. 

The selections in the Task Code drop-down are 
limited to the named Repair Center if one is entered.  

Details: 

If no Repair Center is entered on the Request Log, 
Users see Task Codes for all Repair Centers to which 
they have access. 

 

Criteria Added to On-Hand Adjustment Search 
 

 
Path: Materials > On-Hand Adjustments 
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Contract Find Enhanced 
 

 
Path: Organization > Contract > Records 

Summary: The Criteria drop-down list now includes 
Contract Type as a selection when you create your 
Contracts search. 

Details:  

With this addition, you can add Contract Type as a 
display column in your Contract queries. 
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November 2024 
 

Next PM Date Added to Batch PM Update Window 

 

 
Path: Admin > Batch PM Update 
 

Summary: A new option, Next PM Date, has been 
added to the Batch PM Update window.  

Details:  

This addition makes it easy to mass update multiple 
PM schedules when a client needs to shift a batch to 
a different date.   

Select the lines to change, choose the Mass Update 
button, and use the new field, Next PM Date, where 
you can change the date.  

This change also helps with Load Balancing your PMs. 

This is a Voice of The Customer Enhancement. We 
would like to thank American Airlines, Tarian Group, 
and Johnson Controls for submitting this 
enhancement suggestion. WebTMA has evolved into 
the solution it is largely through great feedback and 
suggestions provided by our clients.  

 

New PM Load Balancing Reports 
 

 

Summary: The PM Load Balance Report in WebTMA 
Report Manager is available to give you a view of 
your Preventive Maintenance program schedule 
throughout the year. 

Using this report helps you ensure you have the 
correct amount of staffing to address PM work orders. 

Details:  

The projected hours are based on the estimated 
hours on the PM Schedule. Optional Report criteria is 
by Repair Center Name. Chart in the report provides 
a bar chart of work order counts that will generate in 
that month and the number of man-hours needed to 
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complete based on estimated time. A further 
breakdown of PM work orders by Priority and Trade 
are listed in the grids. 

Additional PM Load Reports are available from 
Reports > Report Manager, select All > PM. 

This is a Voice of The Customer Enhancement. We 
would like to thank CKS for submitting this 
enhancement suggestion. WebTMA has evolved into 
the solution it is largely through great feedback and 
suggestions provided by our clients.  

 

Biomed Make/Model Linked to Mass Import Tool 
 
 
 

Summary: The Biomed Mass Import Template now 
fully supports Make/Model and Check-In Task 
functionality. The Make/Model features make it easy 
to default information for new Biomed equipment 
based on standards set at the Make/Model level (i.e., 
PM Schedule, manufacturer information, etc.).  This is 
particularly helpful when you have multiple Biomed 
assets of the same make and model. 

For example, if you purchase a quantity of identical 
defibrillators, you can establish the PM Schedule in 
Make/Model and assign it when you import the new 
item information. Subsequent purchases of that same 
make/model can be imported and automatically 
receive the same PM Schedule. If changes are needed 
to the PM Schedule, you can update the Make/Model 
record, and the change is reflected on all records 
associated with that Make/Model. 

The process can also generate a Check-in Task from 
the Make/Model if it exists. If it is not part of a 
Make/Model record, the system looks to the Repair 
Center for the Check-in Task. If none is found, no 
Check-in Task is generated. 

Details:  

If you want PM schedules to be created for the 
Make/Model Biomed items being added, the following 
columns need to be present and valid. If any are not 
valid or not populated, the item is added but no PM 
Schedules are associated. 

• The application will look up the Biomed 
Make/Model based on Make Name, Device 
Type, Manufacturer and Model #. 

• Base PM Date 

• Trade (This is an optional value in the import. 
If Make/Model PM schedule does not have a 
Trade, the Trade from the template is used.) 

• Repair Center  
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Check Results Available for Technician Login 
 

 
Path: Work Order   
 

Summary: When Technicians log in to WebTMA using 
the Technician role, the Work Order window Action 
Menu now includes Check Results. This grants the 
logged-in Technician access to Task Check Lists.  

Details:  

Technicians can record work done using the Check 
List. It provides an easy way to document their work. 

 

New OHA Fields Available in On-Hand Adjustments Report Form 
 

 
Path: Reports > Report Writer  

Summary: The new optional fields included on the 
On-hand Adjustment Entry flyout can be included in 
your Report Writer reports. 

Details:  

The fields labeled Option Field 1, Option Field 2, etc. 
are available for selection from the Add Criteria drop-
down list. 

 

 

New Optional Fields for On-Hand Adjustment  

 
Path: Materials > On-Hand Adjustments 

Summary: You now have the option to add as 
many as four different text fields to the On-Hand 
Adjustment Entry window to capture additional 
information about the inventory adjustment 
transaction (such as additional detail on why it is 
being made). 

The fields are hidden by default. 

Details: 

The fields are labeled Option Field 1, Option Field 
2, etc. as illustrated at left but can be renamed 
using Text Management (Admin > Text 
Management). These fields are alpha-numeric with 
a limit of 255 characters. 

Since these fields may not be needed by all users, 
they are hidden by default. You can go to System 
Form Attributes to make one or more fields Visible.  
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Path: Admin > Form Attributes > System Form 
Attributes (OnHandAdjustment – On-Hand 
Adjustment Entry) 
 

 

Space Management Reject Pending Update Added 

 
Space Management Comparison Table (Drawing to 
DB) 
 

 
Path: Admin > CAD Import 

Summary: Using the Space Management – CAD 
integration (the AutoCAD add-on), you can view 
and export drawing updates for Room Numbers and 
SQF to a staging table in WebTMA.  

You now have the option to reject the imported 
data before committing the changes to the 
WebTMA database. 

Details:  

The drawing changes made are: 

• Add a new room in the drawing (WebTMA can 
create a new Area record) 

• Remove an existing room in the drawing 
(WebTMA can inactivate the record) 

• Change square footage for an Area in the 
drawing (WebTMA can update the SQF for the 
Area record) 

After the drawing updates are exported to 
WebTMA, they remain in a staging area for 
approval before committing the changes to the 
database.  

From the CAD Import window, authorized users 
can either: 

• Import the new information to the database 
by clicking Import Areas on the Action menu 

• Reject the pending changes by clicking Reject 
Import on the Action menu to remove the 
transaction 
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If an export was made in error, the pending 
transaction record is deleted, and no changes are 
made to WebTMA Area records in the database. 

 

Request Log Security Enhancement 
 

 
Path: Admin > User Management > Records / 
Window Access 
Path: Admin > User Management > Groups / Window 
Access  
 
 

Summary: To tighten security on the Request Log 
page, new rules have been established. These 
changes ensure that the rules are enforced on both 
system windows and custom windows. 

Details:  

WebTMA looks at the user or group Window Access 
and applies the following rules.  

Window Button Requirement 1 Requirement 2 

Accept Edit on Request Log Add on Work Ord  

Convert to Project Edit on Request Log Add on Project 

Convert to Audit Edit on Request Log Add on CP Audit 
(Capital Planning) 

Reject/Hold Edit on Request Log  

As an example, to use the Accept button, a user or 
group must be granted Edit on the Request Log 
window and Add on the Work Order window. 

 

Signature Detail for Lines in Key Adjustment Forms 

 
Path: Reports > Report Writer / Identity Tab 

Summary: When you create a new report in Report 
Writer, the Report Criteria drop-down list now 
includes two Signature selections. 

This applies when you use the Signature feature for 
applicable windows. 

Details:  

On the Key Adjustment Form, the Signature criteria 
pulls Signatures for the Header, i.e., one signature 
for several lines. 

The Signature Detail selection pulls signatures for 
individual lines.  

Including signatures in a report may be needed to 
display the physical signature captured, for example 
when issuing or returning keys. The report provides a 
physical document for the key holder to retain. 
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Key Holder History Tab Enhanced 

 
Path: Material > Key Management > Key Holders / 
History Tab 

Summary: The Key Ring column on the Key Holders 
/ History Tab now displays the Key Ring Tag #.  

Details:  

Previously, this column showed the Key Ring 
Description.  

 

Contract Window Offer # Field Now Editable 
 

 
Path: Organization > Contract > Records 
 

Summary: To allow more flexibility, the Offer # field 
on the Contract window can be edited even after a 
Contract is awarded.  

Details:  

WebTMA removed the restriction to assist clients who 
need to make modifications to the field. The Offer # 
can now be adjusted after the fact. 

 

Pending Charges Review/Dispute Location Enhanced 
 

 
Path: Accounting > Post Charges > Pending Charges 
Review/Dispute 
 

Summary: The Location column on the Pending 
Charges Review/Dispute window now shows the 
Location ID. 

Details:  

Previously, this column displayed the Location 
Description. 

 

Criteria Added to Entity Window Selection 
 Summary: A new criteria field selection is available 

on the drop-down selection list for the Entity window 
using Advanced Find (Show the Search Panel). 

Details:  
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Path: Organization > Entity  
 

You can now choose Repair Center Code when 
making your criteria selections.  

 

Preference Label Change – Landing Page 
 

 
Path: Admin > User Management > Records / 
Preferences 
Path: Admin > User Management > Groups / 
Preferences 
 

Summary: When it was first introduced, the Landing 
Page was identified in Preferences as Use New UI/UX.  

Details:  

The label has been changed. To grant user or group 
access to the Landing Page, look for Landing Page in 
User or Group Preferences Tab.  

 

Trade No Longer a Required Field for Master Check 
 

 
Path: Organization > Task > Master Check 
 

Summary: Clients who use the Create Corrective WO 
option on the Master Check window and who also use 
the Client Info / Preference to Force a Trade for Each 
Task, were unable to change the Trade on the 
corrective Work Order. 

Details:  

This has been resolved by removing Trade as a 
required field on the Master Check window. 

In addition, the Trade from the current WO is copied 
to the new WO that’s being generated. This applies if 
the field is not populated. If populated, the system 
will use Trade selected.  
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New Columns on Work Order Task Grid 
 

 
Path: Transactions > Work Order > Records / Identity 
Tab 
 

Summary: Multi-task Work Orders now include two 
new columns in the Task Information Section. The 
new columns added to the grid are Resolution and 
Failure Code. 

Details:  

These new columns give you at-a-glance information 
about Tasks that have failed as well as how they 
were resolved. 

The feature helps ensure that a Failure Code has 
been entered, which is useful when closing and 
completing WOs. 

 

WO Part Request Enhancements Added to WO Action Menu 

  
Path: Transactions > Work Order > Records / Action 
Menu 

 

Summary: Adding Requested Parts to an existing 
Work Order has been simplified. Just select Add 
Requested Part on the WO Action Menu to open the 
Part Request Entry flyout with one click. When 
selecting the Part, you can also choose the 
Warehouse where the Part is stocked. 

Details:  

With the desired Work Order in View mode, click Add 
Requested Part on the Action Menu. The system 
automatically enables Edit mode, moves to the 
Schedule Tab, and opens the Part Requested Entry 
flyout ready for you to request needed Parts. 

These enhancements provide easier navigation when 
requesting a Part and allow you to select the 
Warehouse where the Part is located. 

 

Vendor/Manufacturer/Contractor Mass Import Now Available 
 

 
Path: Admin > Mass Import / Templates 
 

Summary: A Vendor Template has been added to 
the Mass Import list of Templates. 

Details:  

You can import Manufacturers, Contractors, and 
Vendors using this Template, which can be useful in 
several ways. For example, when you build a new 
distribution center or add another campus. In some 
cases, our clients have separate Departments like 
Facilities and Housing. If these are merged, you can 
import data from one Department to another.  
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It is also a good way to update existing information 
such as addresses and contacts.  

The Mass Import module is available for System 
Administrators to import new data or update existing 
data. 

Full details about the module are found at Mass 
Import Module in this document. 

 

Project Module API Endpoints Added 
 

 

 

 
 
 

Summary: Project API endpoints are now available to 
integrate with your external project management 
systems. The endpoints include Projects, Project 
Tasks, and Project Types. This will allow you to create, 
update and monitor project records in WebTMA from 
an external system thus reducing or eliminating 
repetitive data entry. 

Details:  

You have endpoints for Get, Put, Patch, Delete, and 
Post. 

These new APIs are fully described in our Swagger 
documentation. 

 

Keys Module API Endpoints Expanded 
 Summary: We have enhanced our suite of API’s by 

including several new Key-related API endpoints.  

Details:  

The windows included in this release are: Key 
Adjustments*, Keys, Lock, and Key Holders.  

https://app.webtma.com/platformapi/swagger/index.html
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The list of Key-related APIs includes the following: 

Key 

Key Access 

KeyAdjWorkOrderTask 

KeyAdjustment 

KeyAdjustmentDetail 

KeyAdjustmentSignature 

KeyAuthorizer 

KeyHolder 

HeyHolderKeyRing 

KeyHolderKeyRingKey 

KeyInstanceSerialNumber 

KeyTransactionSignature 

The new Keys and Key Holder APIs are fully 
documented in our Swagger documentation here. 

*Note: Key Adjustments are a ledgered system, that 
is, they do not set data. Rather they are a log of 
activity on that key; therefore, Swagger does not 
have Patch or Put. 

 

Criteria Added to Requestor Window Selections 
 

 
Path: Admin > User Management > Requestors 

Summary: Additional criteria field selections are now 
available on the drop-down selection list for the User 
Management > Requestor window using Advanced 
Find (Show the Search Panel). 

Details:  

Look for Requestor Type and Title to facilitate your 
search.  

 

Criteria Added to Contract Window Selections 
 

 
Path: Organization > Contract > Records 

Summary: A new criteria field selection is available 
on the drop-down selection list for the Contract 
window using Advanced Find (Show the Search 
Panel). 

Details:  

Look for Contract Type to facilitate your search.  

 

https://app.webtma.com/platformapi/swagger/index.html
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September 2024 
 

Add Occupants from Area Window 
 

 
Path: Organization > Areas > Records / Occupants 
Tab 
 

Summary: WebTMA Plus clients now have the option 
to assign Requestors as Occupants from the Areas / 
Occupants Tab. 

Previously, this action was limited to WebTMA Base 
clients. 

Details:  

In the past, WebTMA Plus clients were required to 
assign individuals from the User Management > 
Requestors window.  

It is still true that when a Location is assigned from 
the Requestor record, the Requestor is automatically 
added to the Areas / Occupants Tab. 

On the Areas / Occupants Tab in Edit mode, select 
the Add Occupant link on the grid to open the 
Occupants Entry flyout. Mark the desired check boxes 
and choose Add Selected. Once you save the record, 
the Occupants are added. 

 

Languages Supported in WebTMA 7 
 

 
Path: Admin > Client Info / Identity Tab 
 
 

 
Path: Admin > User Management > Record / Identity 
Tab 

Summary: WebTMA now supports languages such as 
Hindi, Punjabi, and Vietnamese for default text labels, 
menus, and messages. Words entered by your users 
in text fields are not translated (Comment field, Name 
field, Request, etc.). 

Details:  

Your WebTMA Administrator determines the default 
language used in the application; however, individual 
users’ preferred settings can be made from the User 
record or from the File > Personal Info window. These 
settings override the Client Info selection.  

NOTE: If you change the personal or User record 
settings, log out of the system. When you log in 
again, you can see the language change. 

The following list shows all the languages that are 
currently supported: 

• English 

• German 

• Spanish 

• Thai 

• French (France) 

• French (Canada) 
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Path: File > Personal Info / Identity Tab 

• Portuguese (Brazil) 

• Portuguese (Portugal) 

• Chinese (Simplified) 

• Indonesian 

• Hindi 

• Punjabi 

• Hungarian 

• Vietnamese 

 

Biomed Mass Import Template Enhanced 
 

 
Path: Admin > Mass Import > Import Dashboard / 
Templates Tab 
 

Summary: The Mass Import Template for Biomed 
Equipment has new columns. This increases the 
number of fields available for import. 

Details:  

Look for the following new columns: 

• Original PO # 

• Status 

• Software Version 

• IP Address 

• HIPAA Frequency 

• HIPAA Comments 

• Annual Rate 

• Usage Flat Rate 

• Owner Department 

• Lease Expiration 

 

New Key Adjustments and Locks Endpoints 
 

 
 

Summary: Key Adjustment and Lock endpoints are 
now available. These APIs allow you to effectively 
manage access control and security within your 
facilities. They are fully described in our Swagger 
documentation. 

Details:  

If you use any of the following types of software, you 
can use these APIs to connect with a broader range 
of services and enhance overall utility. 

• Key Management Software 

• Access Control Systems 

https://app.webtma.com/platformapi/swagger/index.html
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• Locksmith Dispatch and Scheduling Software 

• Inventory Management Systems 

• Customer Relationship Management (CRM) 
Software 

The Key Adjustments API facilitates the management 
of key assignments and inventories. This is crucial for 
operational security and efficiency.  

The Locks endpoint is focused on managing locks 
installed on doors and other access points. 

An additional endpoint for Key Adjustment creation 
will be available in a later release. 

Click here to see lists of the API field names and 
corresponding default langstrings.  

 

Keys and Key Holder API Endpoints Expanded 
 

 

Summary: We have expanded our Swagger 
documentation for Keys and Key Holder API endpoints 
and Schemas. This change provides comprehensive 
documentation for Keys and Key Holders. They have 
been updated to document the full response schema.  

Details:  

The endpoints now map to CREATE (POST), UPDATE 
(PUT and PATCH), DELETE, LIST (GET with no ID), 
READ (GET with ID). 

These APIs are fully described in our Swagger 
documentation. 

Click here to see lists of the API field names and 
corresponding default langstrings.   

The langstrings are the default field labels. If your 
organization has changed the labels, check Admin > 
Text Management to verify the default name. 

 

Edit Budgets for Projects with Estimates 
 

 
Path: Transactions > Project > Records / Costs & 
Budgeting Tab 
 

Summary: Projects with Estimates in WebTMA 7 now 
allow you to manually adjust the budget lines for 
Labor, Parts, and Other in most cases. 

Previously, this action was prevented if the Project 
had an Estimate. 

Details:  

The following rules apply: 

• If an estimate is attached and authorization is 
not required, you can edit the budget lines. 

https://knowledgebase.tmasystems.net/hc/en-us/articles/28530049450637-Key-Window-API-Field-Names
https://app.webtma.com/platformapi/swagger/index.html
https://knowledgebase.tmasystems.net/hc/en-us/articles/28530049450637-Key-Window-API-Field-Names
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• If an estimate is attached and authorization is 
required but not yet approved, you can 
edit the budget lines. 

• If an estimate is attached and authorization is 
required and approved, you cannot edit the 
budget lines. 

• Budgets for Projects without an estimate can 
always be edited. 

 

Filter Parts by Vendor on PO/PR 

 
Path: Admin > Client Info > Preferences 
 

 
Path: Material > Purchase > Purchase Orders 

Summary: Part selections for both POs and PRs can 
now be filtered by Vendor if a setting is granted in 
Client Info / Preferences. 

Details:  

Grant the Filter Parts by Repair Center When Adding 
PO/PR Line in the Materials Management Category of 
Client Info / Preferences. Be sure to log out and log 
in again to see the change. 

Associate parts to the vendor(s) where they will be 
purchased by navigating to the PR or PO windows 
and choosing the Vendor Code. 

When adding parts, the Part flyout now includes a 
check box to Filter Part by Vendor. If checked, 
WebTMA filters Parts by matching the Part Supplier to 
the PO or PR Vendor. 

We would like to thank Abercrombie & Fitch for 
submitting this enhancement suggestion. Moving 
forward as we bring client enhancement submissions 
to reality, we are going to do a better job of 
recognizing the client who submitted the suggestion.  
WebTMA has evolved into the solution it is largely 
through great feedback and suggestions provided by 
our clients.   

 

Login URL with Enhanced Security 
 Summary: You can send a Login URL link to selected 

Users, Requestors, and Technicians that allows them 
to log in without using an ID and Password.  
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Path: Admin > User Management > Records 

Anyone who has access to the URL can launch the 
application; therefore, a 24-hour expiration has been 
applied to resolve a security vulnerability.  

Details:  

Any Login URLs you send to your users will expire in 
24 hours. 

 

Signature Field Available in Key Management Report Forms 

 
Path: Reports > Report Writer / Identity Tab 

Summary: When you create a new report in Report 
Writer, the Report Criteria drop-down list now 
includes a Signature selection. This applies when you 
use the Signature feature. 

Details:  

The selection is available for the following report 
forms: 

• Key Adjustment 

• Key Adjustment All 

• Key Adjustment Detail 

Including signatures in a report may be needed to 
display the physical signature captured, for example 
when issuing or returning keys. The report provides a 
physical document for the key holder to retain. 

This can also be useful to provide receipts to 
departments that need physical copies with 
signatures. 

 

 

Hyperlink to WO from Key Adjustments 
 

 
Path: Material > Key Management > Key Adjustments 

Summary: You can add a Work Order reference 
when making Key Adjustments. The Work Order 
number is now hyperlinked to the Work Order Record. 

The Key Adjustments window is used for transactions 
regarding Keys such as creating, issuing, and 
returning Keys.  

Details:  

For ease of returning to a Work Order to make 
relevant updates, Key Adjustments records that 
include a Work Order number are now linked to the 
related Work Orders.  

Click the Work Order number to open the Work Order 
record. 
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Custodial Template Bulk Copy Window Added 

 
Path: Transactions > Custodial > Custodial Template 
Bulk Copy 
 

 
Path: Transactions > Custodial > Custodial Template 
Bulk Copy 

Summary: To reuse Custodial Templates for other 
buildings or areas, you now have a quick and easy 
way to copy a batch of them using the Custodial 
Template Bulk Copy window. 

The copies can be modified to accommodate new 
spaces without having to make individual copies.  

Details:  

The Custodial Template Bulk Copy is a clean interface 
that is easy to follow. 

 
Simply click the Download Template link on the right. 

The resulting Excel spreadsheet has only two 
columns: 

 
When you have completed and saved the 
spreadsheet, return to the Custodial Template Bulk 
Copy window.  

Click the Upload button at the upper left of the 
window and select the spreadsheet you saved. 

The window displays a line-item list of the Source 
and New Template Codes and indicates if they are 
valid. This gives you the opportunity to amend the 
spreadsheet in case of errors. 

If all entries are valid, click the Bulk Copy button at 
the lower right of the window.  

The new templates are now available, and the 
window is clear. 

Go to Custodial > Custodial Template and review the 
list of Records to view and amend your copied 
Templates. 

Search Option Added to Task Check List Flyout 
 Summary: When you select Add Check on the Task / 

Task Check List Tab, the Task Check Entry flyout now 
includes search fields to help speed finding checks. 
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Path: Organization > Task > Records / Task Check 
List Tab 

The check items for Technicians to follow when they 
perform a Task are created from Organization > Task 
> Master Checks.  

Once you have created the check list selections, they 
are available for selection from the Task Check List 
Tab). 

Details:  

The new search fields provide the option to search by 
either the Check Code or Check Description, where 
no search option was previously available. 

This is helpful for clients that have many check items 
so they can quickly find the relevant items. 

 

OTP Search Option for Purchase Requisitions 
 

 
Path: Material > Purchase > Purchase Requisitions 

Summary: OTP parts are now options in the Find 
window. If you have many OTPs, you can quickly 
search for those records in existing PRs by Part Code.  

The Purchase Requisition module is used to request 
purchases for many reasons including One-Time 
Purchases (OTP) for materials or services. 

Details:  

On the Purchase Requisitions window, choose the 
Show Search Panel  icon from the Navigation 
Panel.  

Select Part Code as a criterion on the Find flyout and 
enter the full or partial OTP number to see the 
Purchase Requisitions that include the related OTP 
records. 
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July 2024 
 

Executive Dashboard Enhancements 
 

 
 

 
 

 
 

Summary: Based on the large number of requests 
from clients familiar with the v5 Dashboard 
functionality, we have added several enhancements 
to the v7 Dashboard. This results in a v7 Dashboard 
that has the best of v5 and the ease of use from v7. 

Details: 

Responsive Content. The contents grow or shrink 
with the size of the box and are centered within the 
box. Previously, the font was difficult to read because 
of the smaller size, and it had too much unused white 
space. 

Pie Chart Legend. The legend was moved to the 
bottom from the right side. This allows the font to be 
larger and eliminates the cutoff that occurred with 
some configurations. 

Ability to Create Wider Dashboards. If you want 
to display more controls on a single row and take 
advantage of larger monitors/screens, the Dashboard 
now provides a way to set the number of columns to 
display. This allows you to maximize the dashboard 
area and reduce or eliminate blank spaces on the 
right. To use this new feature, click Manage Tabs on 
the Action Menu and enter a number in the Columns 
in Layout column on the Tab Manager flyout. One 
column equals 150 pixels (px). 

Bar Chart Labels. Bar chart labels are now 
displayed vertically by default. This eliminates the 
way horizontal labels overlapped, and many became 
impossible to read. With the move to vertical, we 
realized that large labels caused the label area to 
compress the bar chart area. To prevent this 
compression, we have set the maximum label length 
displayed to 20 characters. In the near future, we will 
add a configuration option that allows you to 
configure the label orientation (horizontal, vertical, 
diagonal).  

Segment Color Highlights for Digital Controls. 
You can now define different colors based on the 
number returned in the control. This provides a quick 
visualization to let you know if everything is running 
optimally in your organization or if an area needs 
attention. As an example, if you have a control that 
displays the count of past due work orders, you can 
specify green for readings of 0-10, yellow when 
readings are between 11-50, and red for readings 
between 51-999,999. For the final range, be sure to 
select a value that can never be attained. 
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Action Menu: Manage Tabs – Auto Refresh Column 

Refresh Frequency. With the last release, we 
introduced automatic refresh for Dashboard tabs that 
were checked. In the 4/30/2024 release, the refresh 
frequency was automatically set to every fifteen (15) 
minutes. In the current release, the refresh 
frequency has been changed to every five (5) 
minutes. In a future release, we will add 
configurability where you can better control the 
frequency of the refresh rate. While it does not auto-
cycle through the tabs, this will be added in a future 
release. 

 

Alert Based Work Orders with Smart Building Integration 
 

 
 

Summary: WebTMA 7 now integrates with BACnet to 
communicate with Building Automation Systems 
(BAS) or Business Management Systems (BMS).  

The Smart Building Integration additional module is 
required to utilize BACnet integration. 

Details:  

For TMA clients that have BAS or BMS in use, BACnet 
monitors the readings and can communicate alerts to 
TMA to trigger work orders when a BAS or BMS alarm 
occurs. 

 

Landing Page Revision 

 
  Supervisor’s View 
 

Summary: The Landing Page has two Tabs: Work 
Orders and Active Tasks. The Work Orders Tab is 
useful for Supervisors, but not other users. With this 
revision, only Technicians marked as Supervisor and 
selected as Supervisor for a Trade or Trades will see 
the Work Orders Tab.  

The change makes it faster for logged-in Technicians 
to see their Tasks without using extra clicks and 
ensures they do not have access to mass update 
functionality. 

Details:  

If the logged-in user has the Supervisor check box 
marked on their Organization > Repair Centers > 
Technician record, the Work Orders Tab is visible. 
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  Non-supervisor’s View 
 

 
The work orders that display on the landing page are 
limited to Trades that the logged-in supervisor 
manages as designated from the Organization > 
Repair Centers > Trade record. 

 
If the Supervisor wants to assign work from the 
Landing Page, they must have the assigned Privileges 
"Allow to schedule work to others" found in Admin > 
User Management > Records / Preferences Tab. 

 

Parts Available List Refined for Landing Page 

  
 Default View – Include Unavailable Parts 

Summary: Material Costs can be posted to a Task 
from the Active Tasks Tab on the Landing Page, and, 
by default, the parts list includes unavailable parts. 

   
The selection list that displays when you click the 
+ Add Part button now offers an option to remove 
from view the parts that have an available count of 0. 

Details:  

We have added an Include Unavailable Parts check 
box on the Post Material for Task popup window. The 
box is marked by default.  

When you clear the check box, parts that show an 
available quantity of 0 are removed from the list. This 
is a toggle action. If you mark the check box once 
more, the zero quantity lines reappear. 

The screenshots at left illustrate the location of the 
check box and the different views.  
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  No Unavailable Parts 

If you have a long list, it may take a moment to 
revise the page. 

 

Mass Import Template for Equipment Enhanced 
 

 
 New Columns in Template 
 

Summary: The Mass Import Template for Equipment 
has new columns that accommodate users of the 
Make/Model feature. Make/Model makes it easy to 
establish records and add PM Schedules when you 
add large quantities of items of the same make and 
model. 

For example, if you purchase a quantity of identical 
air conditioners, you can establish the PM Schedule in 
Make/Model and assign it when you import the new 
item information. Subsequent purchases of that same 
make/model can be imported and automatically 
receive the same PM Schedule. If changes are 
needed, you can update the Make/Model record, and 
the change is reflected on all records associated with 
that Make/Model. 

Details:  

If you want PM schedules to be created for the 
Make/Model Equipment being added, the following 
columns need to be present and valid. If any are not 
valid or not populated, the equipment is added but 
no PM Schedules are associated. 

• One of the combinations below is needed. If 
Manufacturer, Model, and Equipment Type are 
present in the template, then the lookup for 
the Equipment Make/Model is based on 
Manufacturer and Model. 

- Make, Manufacturer, and Model 

- Make, Type and Sub-Type (if Sub-Type is 
used), or Type only 

• Base PM Date 

• Trade (if M/M PM schedule does not have a 
Trade, the Trade from the template is used) 

• Repair Center 
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Time & Attendance New Criteria 
 
 

 
Path: Transactions > Time Manager > Time & 
Attendance 

Summary: To allow you to review labor hours by 
Work Order Types or by Priority, new criteria have 
been added to the Time & Attendance query for WO 
Type and Priority. 

  
 

Details:  

When you add these new criteria, you can do the 
following: 

1. Click the Display Column sub-tab. 

2. Select Add Column. 

3. Check any of the boxes in the Display Column 
Selection. 

4. Save the Query with a unique name. 

You can use the saved Query in a Dashboard based 
on labor lines, for example, ‘Number of Hours 
Completed by WO Type’. 

 

Shift Schedule Option for Scheduler 
 

 
Path: Transactions > Time Manager > Scheduler -
Action Menu - Shift Schedule 
 
 

Summary: When unscheduled events occur which 
impact work order scheduling (illness, vacation, 
holidays, etc.), you can easily change technicians’ 
scheduled assignments by a specified number of days 
or a specific date. 

Details:  

In the grid, check the desired technician lines and 
select Shift Schedule on the Action Menu. 

Both Days and Dates can be moved forward or 
backward. 

Shift By Days. Enter the number of days to move 
the work. A negative value shifts work to an earlier 
date. 

Shift To Date.  Select a date and time before or 
after the current date. 
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Click the Save button on the flyout, and then choose 
Save on the WebTMA toolbar. 

 

Default Grid Records Returned Expanded 
 
 

Summary: Many clients have requested that we 
increase the number of records returned in the grids 
to reduce the number of pages you have to scroll 
through to see your data.  

Details:  

Most grids now display 25 rows compared to the 10 
records returned in the past. We limited the records 
returned by default to optimize system performance.  

Examples of grids updated to the higher record count 
include:  

• Work Order > Labor/Parts/Other Charges 

• Quick Post Cost 

• Project > Task & Resources 

• Purchase Order > Purchase Order Lines 

See the example below of the Work Order Labor grid. 

 
 

Task Code Character Length Increased 
 
Path: Organization > Task > Records 
 
 

Summary: The length of Task Codes has been 
increased from a maximum length of 14 characters to 
30 characters.  

Details:  

Several clients requested this change to make use of 
ASHRAE codes which can be up to 21 characters in 
length. We expanded to 30 characters to assure we 
had ample space to accommodate future Task Code 
configurations. 

 



  36 

New Simple Work Order Format 
 

  
Path: Transactions > Work Order > Records 

Summary: Several clients asked for a simplified 
Work Order that could print/render more quickly from 
the Work Order window. You now have the option of a 
Simple Work Order or the original Work Order 
available in the Reports panel. 

Details:  

The new simplified Work Order layout is easier to 
read for basic work orders. Also, it is optimized to 
render more quickly. The new report is named Simple 
Work Order. 

It has a significantly reduced number of fields on the 
printout to show only the most relevant information. 
It is designed with Technicians in mind who print 
Work Orders. The report allows space for handwritten 
notes, hours, comments, signatures, etc. The system 
renders the printout in one (1) second compared to 
five (5) seconds for the original work order printout. 

For cases where you need more details, the original 
Work Order report is still available.  

 

Signature Feature Added to Several Windows 
 

 
Path: Material > On-hand Adjustments 
Path: Material > Parts > Transfer Parts 
Path: Material > Sales > Sales Order 
Path: Transactions > Quick Post > QP Material 
Path: Transactions > Quick Post > QP Cost 
Path: Transactions > Work Order > Records 
Path: Organization > Areas > RI Inspections (per line 
item in the grid) 

Summary: We have added the ability to capture 
physical signatures to several windows in the 
application. 

Details:  

This feature is now available on the Action Menu of 
the following windows: 

• On-hand Adjustments 

• Sales Orders 

• Transfer Parts 

• Work Orders * 

Signatures can only be added in Add mode and 
cannot be edited or altered. 

If Client Info / Preferences–Materials Management 
“Require Signature on Material Transaction” is 
granted, the following windows have a signature 
window on big Save. 

• Quick Post Material  

• Quick Post Cost 

• Work Orders * 

In the case of Room Inspections, line items can have 

a signature added using the signature icon . 
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• Room Inspection 

* Work Order signatures can have two possibilities. 
The first is available from the Action Menu. The 
second occurs if Client Info / Preferences–Materials 
Management has “Require Signature on Material 
Transaction” Granted, then the system will force a 
signature after big Save when a Material Cost is 
added. 

 

UFI Export Date Now Uses 24-Hour Format 
 
Path: Accounting > UFI > UFI Export Data 
 
 

Summary: The date format has been changed from 
HH to HH24. 

Details:  

Some Oracle database versions were having difficulty 
processing the date/time format used by the UFI 
application. They required the 24-hour format. If you 
export UFI data to an Oracle Database, the new date 
format will be applied. SQL Server integrations 
remain unchanged. 

 

UFI Segment Validation Feature Added 
 
Path: Accounting > UFI > UFI Segment 
 
 

Summary: The UFI Segment entry now checks to 
confirm that the account number entered is valid.  
This helps avoid failures in the interface due to 
mistyped account numbers. 

Details:  

When you enter data for the account, the system 
checks to verify if it is a valid entry. If invalid, you 
are alerted. 

 

Work Request API  
 Summary: A new, easier to use, Work Request API 

has been added to our API suite. This API is designed 
to accept system codes rather than database ID’s for 
most of the lookup fields available for the creation of 
a Work Request (Service Request). The current Work 
Request API requires multiple API calls to look up 
database IDs for fields like Request Type, Repair 
Center, Facility, Building, etc. 

The new API option allows clients to pass the system 
visible codes instead of the database ID. This is a new 
API (additive) and will not replace the existing API 
(Requests). Any client using the current Requests API 
can continue to use that API as is. 

Details:  
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WorkRequest. The new WorkRequest API is fully 
documented in our Swagger documentation. 

This new API is easier for clients to consume and 
requires fewer API calls. This API is used to create 
(Post) and obtain status (Get) for Work Requests 
(Service Requests). 

 
 

Go Live Date for New Repair Centers 
 

 
Path: Organization > Repair Center > Record / 
Identity Tab 
 
 

Summary: A Go Live Date field has been added to 
the Repair Center / Identity Tab General Information 
Section. It allows you to add an effective date for 
Make/Model PMs when you add a new Repair Center.  

This is useful for clients that set up a new Repair 
Center in advance of using it. When you add a new 
Repair Center to accommodate a new department or 
location, for example, a date in this field prevents 
PMs from being generated before they are needed. 

Details:  

The date is only used when Make/Model creates new 
PM schedules. It will not be used for or impact 
manual entries or existing schedules. 

The date selected in this field prevents PMs from 
being generated until after the Go Live Date. For 
example, if you have a monthly PM on an item and 
the Go Live Date is 8/1, rather than setting the PM 
next date to the date the record is created, the PM 
date is pushed to 8/1 to align with the Go Live Date. 
Once the date is reached, it is for information only. 

https://app.webtma.com/platformapi/swagger/index.html
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Billing Review/Dispute (WebTMA Plus) Enhanced 
 

 
Path: Accounting > Post Charges > Pending Charges 
Review/Dispute 
 

Summary: Authorized users or requestors can 
review and dispute charges related to account 
transactions based on Department records from the 
Pending Charges Review/Dispute window.  

The Sub-Ledger Browse form now has an additional 
column. 

Details:  

If your System Administrator has performed 
Review/Dispute Administrative Setup, you can create 
a Batch Job to Post Charges to Sub Ledger that allows 
you to review the charges and dispute questionable 
items.  

The Account View section of the window now includes 
the Location column to save you time when reviewing 
the records.  

 

Contracts Window Department Field Added 
 

 
Path: Organization > Contract > Records / Identity 
Tab 

Summary: You can award contracts to outside 
contractors after a bid process. Information about the 
Contract is recorded on the Contract window.  

Details:  

The Department Code, a new field on the Identity 
Tab, helps you identify the Department associated 
with the contracted work. This is an elective field. 
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May 2024 
 

Custom SQL Window Added 
 

 
Path: Admin > Custom SQL 

Summary: WebTMA v7 now includes the Custom 
SQL window. Use Custom SQL to copy standard 
System Queries or write and test your own SQL 
queries for the Executive Dashboard.  

In use, your users can view a data set represented 
on a graph, such as the data for a segment of a pie 
chart. By applying a drill-down query, you can click 
on a section and display a list of the underlying data 
in tabular format.   

Details:  

To enable the custom SQL window for your on-
premise environment, click here. 

Once custom SQL is enabled for your site, a new 
custom SQL can be created by going to Admin > 
Custom SQL and copying an existing or adding a new 
Custom SQL following the rules outlined here.   

Your custom queries have several restrictions to 
protect you from malicious users that have SQL skills, 
for example, the term 'exec' is on the list of 
unacceptable keywords. The term will be screened 
out of any query and result in an error. In addition, 
all queries must start with SELECT and must be 
tested. If you have not clicked the Test Query button, 
an alert reminds you. 

Queries are listed in the Records section of the 
Navigation pane.   

System queries are identified by a mark in the 
System Query check box below the Drill Down Query 
field. System queries cannot be edited.  

Full details about Custom SQL are available here. 

 

Favorites and Bookmarks Extended to New UI/UX 
 
 

 

Summary: As WebTMA continues to make the user 
interface easier to use, the Bookmark and Star icons 
are now available on the New UI/UX interface. 

Details:  

A Bookmark  icon is available to mark individual 
New UI/UX records. 

The Star  icon is visible on the New UI/UX menu 
bar with a drop-down of Favorites and Bookmarks set 
throughout the application. 

https://knowledgebase.tmasystems.net/hc/en-us/articles/26574247400333-Enabling-Custom-SQL-Window-for-Dashboards-for-On-Premise-Installation
https://knowledgebase.tmasystems.net/hc/en-us/articles/27315957040269-Custom-Query-Rules
https://knowledgebase.tmasystems.net/hc/en-us/categories/27193822592525-On-Premises-Custom-SQL
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Bill of Materials New Columns in Table View  
 

 
Path: Material > Bill of Materials 
 
 

Summary: The Bills of Materials window is an easy 
way to associate needed Parts with many items at 
one time. The Table View has been revised to replace 
certain columns and add new columns for more 
information. You also have the option to Sort and 
Filter each column. 

Details:  

Look for the  icons in the headings for the 
following columns: 

• Code 

• Name 

• Created Date 

• Modified Date 

• Part Count (new) 

• Item Count (new) 

• Active (new) 

 

Audit History View Added 
 
  
 

Summary: The Audit History View is now available to 
help simplify your reporting process. 

Details:  

This is a view to access when you build your own 
reports using the report writer application of your 
choice.  

 

Equipment Record Design Change for Make/Model 
 

 
Path: Equipment > Records / Identity Tab 
 

Summary: The Make/Model feature in WebTMA allows 
clients to create templates for equipment 
management. This allows for more efficient 
standardization of PM schedules, parts list, costing, 
life expectancy, SOPs, and documentation.  

The workflow process on the Equipment window has 
been revised for ease of use in assigning Make/Model 
and creating PM schedules. The Base PM Date field 
has been moved, and a Select Repair Center flyout 
has been added. You can now make all these 
selections from the Equipment / Identity Tab. 

Details:  
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Previously, the Base PM Date was in the Dates 
section. It is now in the General Information section.  

When you select a Make/Model Type, the Base PM 
Date field becomes required if the Make/Model has 
PM schedules. 

An entry in the Base PM Date field triggers the 
following alert: 

 
If the record does not have any linked Repair 
Centers, click OK on the alert to open the Select 
Repair Center flyout. 

When you choose and save a Repair Center on the 
flyout, the RC is added to the Equipment / Repair 
Centers Tab. 

If the Make/Model / PM record has no RC, it defaults 
to the selected RC.  

 

Report Writer – Report Criteria Syntax Link Added 
 

 
Path: Reports > Report Writer / Identity Tab 

Summary: You now have a way to confirm that you 
have structured your query accurately to achieve the 
desired results. When you add Report Criteria to your 
report, you can click a link to display the Syntax of 
your criteria. 

Details:  

The Criteria Syntax link is available in View, Add, or 
Edit mode. 

Click the link to open the Criteria Syntax flyout to see 
the syntax. 

 

Requestor Login – Request Status Browse Date Range Added 
 
 

Summary: You now have a way to select the time 
frame of records you want to see in Requestor Login 
Status Browse. Before this change, the system could 
time out while it attempted to load all records. The 
Work History grid now includes fields to set the time 
frame for viewing and reporting. 

Details:  
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The default interval is the Last 30 Days, but you have 
the option to select any of the options illustrated in 
the screenshot at the left.  

You can also search up to one year of historic data, 
and you can determine the year to be searched. If 
you need to see, for example, FY 2020-2021, just 
enter a Start Date of 07/01/2020 and End Date of 
06/30/2021. 

Pending Request results are also limited to the 
specified range.  

 

UFI Export Date Default Changed 
 
Path: Accounting > UFI > UFI Export Data 
 
 

Summary: If a date format is not set up for the UFI 
Template, a new default is applied. Oracle databases 
expect the 24-hour format illustrated below. 

Details:  

When you do not set up a date format for the UFI 
Template, the output for flat files and SQL Server will 
default to the following 24-hour format: 

yyyy-MM-dd HH:mm:ss (example: 2024-04-04 
17:05:37) 

 

Mass Import Template for Fuel & Oil 
 
Path: Admin > Mass Import > Dashboard 

Summary: In ongoing support for our Mass Import 
tool, another template has been added: Fuel & Oil. 

Details:  

Fields found on the Fuel & Oil window are available 
for completion on the Excel spreadsheet, including 
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Meter and Odometer entries. Six fields, such as 
Ticket # and item Tag # are required. 

The Mass Import module is available for System 
Administrators to import new data or update existing 
data. 

Full details about the module can be found at Mass 
Import Module on page 47. 

 

Signatures Added to Key Adjustments 
 

 
Path: Material > Key Management > Key Adjustments 

Summary: Signatures can be used to capture a 
physical signature in an electronic format when you 
issue keys. With a signature, users acknowledge their 
key-holder responsibilities specified by your 
organization. In this release, you have the option to 
add a hand-written signature to Key Adjustment 
transactions.  

Other modules that qualify for signatures will be 
available in the next release. 

Details:  

The signature can only be added in Add mode and 
cannot be edited or altered. 

For a Key Adjustment that qualifies, use the  
Signature button for each line item or Signature on 
the Action menu. 
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March 2024 
 

New Home Page User Interface (UI) 
 

 
New Home Page – Default View 

 
 
 
 
 

 
  Top Menu 
 
 
 
 
 

 
  Filter Field 
 
 
 
 

 
Work Order View 

 
 
 
 
 
 

Summary: A dynamic new Home Page is now 
available. You have the option of switching between 
My Dashboard and this new page. 

Discussion: 

The new page is designed for quick visibility and easy 
access to your high priority items such as Work 
Orders and Active Tasks.  

To see the new Home Page, select the  WebTMA 7 
icon. 

At the upper right of the new Home Page, select the 

 Quick Action button to quickly create any of the 
following: 

• New Work Order 

• New Purchase Order 

• New Purchase Requisition 

The new Home Page has two views: 

• Work Orders (default) 

• Active Tasks 

Any time you want to revert to My Dashboard, select 

the  My Dashboard button at the top right. 

The menu at the top of the Home Page is the same 

with the addition of an  icon you can select to 
display a Filter field and search the entire application. 

WORK ORDER VIEW 

The Summary section of the default Work Order view 
shows a summary of all Work Orders with these 
statuses: 

• Open 

• Overdue 

• Finished 

• Unassigned 

Select one of the buttons to display a list of the 
underlying work orders in the Work Order Tasks 
section. 

Use the Filter buttons at the top of the columns 
to see the desired Work Orders.  You may also take 
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Active Tasks View 

 
 
 
 
 
 
 
 
 
 
 

 
 

 

action by marking the check box on a Work Order(s) 
and choosing one of the following buttons from the 
top right of the list: 

 Update Status: Update the Status of the WO 

  Assign Technician(s): Assign a technician to 
the WO 

  Update Due Date: Update the Due Date on 
the WO 

  Export to CSV: Export to a csv file 

  Print: Print the WO  

ACTIVE TASKS VIEW 

The Active Tasks view shows a Due Date Breakdown 
and an Active Task List. 

In the Due Date Breakdown section, you see all your 
active tasks categorized by the following statuses: 

• Overdue 

• Today 

• Next 7 Days 

• After 7 Days 

• No Due Date 

Select any of the buttons to display only those items 
in the Active Task List below. 

Select the buttons at the right of a line item to: 

  Post Cost: Opens Work Order Cost Entry 

  Add Task Comment: Add comments to Tasks 

  Print: Print the Task 

 

 

Bill of Materials Added 
 Summary: A Bill of Materials (BoM) can now be 

created and assigned for maintenance-worthy items. 

Discussion:  
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The BoM accommodates a comprehensive list of 
parts, items, assemblies, and other materials for your 
maintenance-worthy item. 

Select Material > Bill of Materials to open the new 
window where you see the BoM groups as well as 
create new BOM Groups and select parts and items. 

The Part Reference Tab on the following MWI 
windows now includes a BoM Group Parts section:  

• Entity 

• Equipment 

• IT Equipment 

The XRef Tab on the following MWI windows includes 
a BoM Group Parts section: 

• Biomed 

• Asset 

• Vehicle 

The Parts / XRef window also includes a BoM Group 
Items section. 

 

 

Mass Import Module 
 Summary: The Mass Import module is available for 

System Administrators to import new data or update 
existing data. 

The new menu options are available on the Admin 
menu. Go to Admin > User Management > Records / 
Window Access to give your administrative user Full 
access to the new window. 
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Mass Import Module 

 
Path: Admin > Mass Import > Dashboard 
 

 
 

 
 

 
   

  

Discussion:  

The Dashboard view shows Import history as a 
graphic summary and individual files. 

The Templates tab shows a list of the available Excel 
Templates you can download and complete before 
importing. The list of Templates will increase in the 
future. 

Select the desired link or  button to download the 
template. 

Once the template is completed, you can use the 

 Create Import button on the 
Dashboard or use the menu Admin > Mass Update > 
Create Import. 

Select the Data Type of your import template 
(Equipment, Asset, etc.), and click the Choose button 
to select your completed Excel spreadsheet. 

Click the  Next > button to see your data 
before import. 

The results display with an indication of the status of 
each line:  Create, Update, or 
Invalid. 

You can use the Selection Mode buttons to make 
changes to a line. First, select the initial button: 

  
This enables the other buttons: 

 
Select a cell in the table to make the desired change 
in the Update Selected Fields popup pictured at left.  

When the data is ready, click the  Import > 
button. 

NOTE: If the data needs serious attention, you can 

select  Close on this window without 
importing, revise the Excel spreadsheet, and try 
again.  
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CAD Import Department Codes Available 
 
 
Path: Admin > CAD Import 

Summary: Department Codes are now an option 
when using CAD Import.  

Discussion:  

Previously, Department Descriptions were available, 
but the Department Code was not an option. You can 
now import both Description and Code. 
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